
HP IT Executive Scorecard
Software Version: 9.50
Windows ® operating system

Content Extension Guide for XS IDE Version 9.50

Document Release Date: February 2015
Software Release Date: June 2014



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard
commercial license.

Copyright Notice
© Copyright 2011-2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

AMD is a trademark of Advanced Micro Devices, Inc.

Intel and Xeon are trademarks of Intel Corporation in the U.S. and other countries.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hp.com

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:
https://hpp12.passport.hp.com/hppcf/createuser.do

Or click the the Register link at the top of the HP Software Support page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at: https://softwaresupport.hp.com

This web site provides contact information and details about the products, services, and support that HP
Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
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l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to:

https://hpp12.passport.hp.com/hppcf/createuser.do

To find more information about access levels, go to:

https://softwaresupport.hp.com/web/softwaresupport/access-levels

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables
you to explore HP Product Solutions to meet your business needs, includes a full list of Integrations between
HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp

About this PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple
topics from the help information or read the online help in PDF format. Because this content was originally
created to be viewed as online help in a web browser, some topics may not be formatted properly. Some
interactive topics may not be present in this PDF version. Those topics can be successfully printed from
within the online help.
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Getting Started with Content Extension
The Integrated Development Environment (IDE) allows you to develop content and DWH models, as
well as develop new entities and extend existing content using the Designers. Once the entities are
defined andmapped, they are run through the ETLGenerator to produce themetadata and workflows.
You can then package the data into Content Packs for use in the DataWarehouse.

Note: The IDE only supports the usage of UTF-8 (Latin) characters.

IDE Set up
1. Prerequisite:When creating or extending content make sure that you have set up IT Executive

Scorecard. For IT Executive Scorecard installation and administration details, see the IT
Executive Scorecard Administrator Guide.

2. Install the contents of the IDE DVD. The IDE can be downloaded from HP Live Network
(https://hpln.hp.com/group/executive-scorecard) and contains:
l IDE:Unzip the file and double-click eclipse.exe to run the IDE Eclipse application.

l IDE Content:Contains the OOTB Content Packs.
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Content Extension Process
The development of new content comprises the following steps:

1. Understand IDE. For details, see "IDE Terms" on the next page, "IDE Audience" on page 11, "IDE
Main Page" on page 26, and "Content Packs and DataModeling" on page 21.

2. Design and analyze the purposes of the extension. For details, see "Design and Analysis Phase"
on page 13.

3. Data Evidence: Understanding and analyzing what data needs to be included, based on your
information needs and objectives. For details, see "Discover Data Evidence" on page 17.

4. Import existing content for extension or new Content Pack directories if required. For details, see
"Import Existing Content" on page 58.

5. If needed, define new Content Pack projects. For details, see "Define New Content Pack Project"
on page 59.

6. Modeling: The architect creates the Target model. For details, see "Define the Target Model" on
page 64 and "Architect Target Designer Tasks" on page 34.

7. Data Source Integration: The engineer maps the data from the Source to Target. For details, see
"Engineer Stream Designer Tasks" on page 46, "Delete an Entity Permanently" on page 66, and
"Manage Validation" on page 68.

8. ETL development and generation. For details, see "Generate Content" on page 80.
9. ETL orchestration andmanagement. For details, see "Package and Deploy Content" on page 82.
10. Activate new content. For details, see "Activate New Content " on page 84
11. Consolidation
12. Context (universe) building and adjustments.
13. KPIs additions andmodifications.
14. Advanced development. For details, see "Advanced Development" on page 90.
15. Next steps. For details, see "Next Steps" on page 114.
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The IDE End-to-End Flowchart
The following illustrates the typical flow, tasks, and procedures in the IDE process. The tasks
correspond to the relevant tasks in the Designers.

IDE Terms
l IDE: Integrated Development Environment. The Eclipse workspace where you can create or
extend content usingmodeling tools in the relevant designers.
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Note: The path to the workspace should not contain blank spaces. For
example: C:/workspaces/ide_workspace/.

l KPI: Key Performance Indicator. KPIs reflect how well the organization is doing in areas that
most impact financial measures valued by shareholders, such as profitability and revenues.

l API: Application Programming Interface. A specification intended to be used as an interface by
software components to communicate with each other.

l ETL: Extract, Transform, Load. An end-to-end transfer of external source data through several
staging layers and into the target layer of the data warehouse. The data warehouse uses the ETL
process to extract, consolidate, and transform the source data into ameaningful target model that
populates relevant business analytics.

l UDM: Unified Data Model. Provides a bridge between the user and the data sources.
l DWH: Data Warehouse. The data warehouse is an end-to-end solution for extracting source data
and consolidating disparate source datamodels into a consolidated datamodel. The data organized
to reflect this model resides in target tables that become the source for XS.

l XS: [[[Undefined variable Project_Variables.BA]]]. An application that enables executives to
continuously improve their business by measuring what happened and what is happening, analyzing
that information, and planning new strategies using the gathered information.

l File Based Integration (FBI) Extractor.
FBI enables you to extract data from a specific data source according to a set of instructions. It
consists of a plug-able extractor framework for each data source. The extractor gathers data
according to the specific instructions it receives, placing it into a relevant .txt flat file. If you want to
develop your own extractor for use with extended content, see the FBI Extractor SDK Guide.
The following extractors are available for each source product:

Product Extractor

ALM ALM11, ALM11.5/12

AM MSSQL, Oracle

AWS aws_s3

AWSCW AWSCW

BSM BSM, GDE, UCMDB

CSA CSA

DP DP

FPA FPA

IC MSSQL, Oracle, PostgreSQL

NA MSSQL, Oracle, MySQL

NNM NNM
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Product Extractor

OO MSSQL, Oracle, MySQL

PPM Oracle

SA SA

SE Oracle

SM MSSQL, Oracle

UCMDB UCMDB

VCM script(groovy)

l Entity. An entity is an object of interest included in the datamodel.
l Designer. A designer in the IDE is themodel you create in order to perform content extension and
definition. It is a collection of certain entities that may share some relevancy in common. The IDE
contains the Architect Target Designer and the Engineer Stream Designer.

l Content Packs. A content pack is a set of entities from a certain type. There are three types of
content packs:
l Source. Contains all of the artifacts needed to connect to the relevant data source and pull data
from that data source.

l Integration. Integrates the information from the source, using the DWH schema and loading
process in order for the data to be brought to the Target tables. Takes the schema and entities of
the source data and transforms it into usable data.

l Target. Defines the content of the DataWarehouse as well as the look of the target tables
according to the Unified DataModel (UDM).

IDE Audience
This document assumes basic data warehousemodeling knowledge, understanding of the ETL
concepts, good familiarity with databases including the SAP Business Objects Data Services (BODS).

Requirements for DWH Architects
l Understanding of Business Intelligence tools, data warehousemodeling and database design
principles.

l XS DWH Target schema.
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Requirements for DWH ETL Engineers
l Understanding ETL principles.
l Familiarity with the source schema.

Requirements for DWH Integration Engineers
l Java programming skills

Prerequisite Knowledge for Performing Content
Development Tasks
l HP Unified DataModel (UDM).
l Target Model: The existing supportedmodel of the DWH
l Basic architecture of the data warehouse and the advantages of the templates.
l Basic familiarity with the Integrated Development Environment (IDE).
l Verticaand datamodeling.

Content Development Process
The content development process includes several stages:
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Design and Analysis Phase
The information design and analysis phase help you determine your organization’s objectives and
information needs and discover the data in the organization that supports the business requirements.

Learn More

Design and Analysis
This phase is the preparation for the actual implementation but usually consumes more time and
resources as the outcome of it should be exact design of the end user solution.

This phase has the following stages:

Business Discovery

A structuredmethodology for understanding the company’s objectives and Information needs.

This methodology includes the following steps:

1. User Analysis.
l Define the personas

l Define the personas business requirements

2. Decision Based Analysis.
l KPIs

l Reports

l Metrics

l Dashboards

3. Information Availability.
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l Identify the Source systems that support business requirements

4. Assign Priorities.
The output of this stage is the design document that describes the solution from business perspective.

Information Discovery

This stage implies discovering the data in the Organization that supports the Business requirements
synchronizing between the available information, means of extracting it and information required by the
business. It’s also known as “Data Evidence” process

Discover the data in the organization that supports the business requirements. Synchronize the
available information and themeans of extracting it with information required. This is the Data Evidence
process. Information discovery includes the following steps.

1. Select the Source Contact Point.
l Select a source expert to accompany the information discovery process

2. Define the Source Extraction Method.
l Common extractionmethods are DB query, API, Web Services

l The new extractors can be developed based on the FBI API.

3. Identify the Source Table.
l Identify configuration tables to populate Dimensions

l Identify transactional tables to populate Facts

4. Define the Source to Target Mapping.
l Identify Source Columns Mapping to Target Columns

l Define data-processing requirements

Architecture
During this stage the Target datamodel is visualized using the Star-SchemeModel approach. Star
Schema is a designmethod of dimensional modeling, in which data is organized in:

l Facts:An event that is counted or measured, such as a sale or logon. Table Structure contains
business measurements (numeric or time based) and Dimensional Intersection Point.

l Dimensions:Reference information about the fact, such as period, product, or customer. Common
Table Structure contains descriptive attributes.

A star schema is diagrammed by surrounding each fact with its associated dimensions. The resulting
diagram resembles a star. Star schemas are optimized for querying large data sets and performing
analytical queries that are used in data warehouses and Business intelligence systems.

Sample Star Schema
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The Star-Scheme architecture creation process includes:

l Review the XS UDM catalog.
l Review the XS UDMCatalog, by the business context defined in Business Discovery phase.

l Gap Analysis
l Identify the OOB Target entities matches.

l Identify the OOB Target entities to be extended.

l Identify the New Target entities.

l Design Dimension Tables
l Define the Attributes.

l Mark Slowly Changing Dimension columns

Note: DWH supports 2 types of Slowly Changing Dimensions:

l SCD1: no history preserving an update on one or more attributes will override the old value

l SCD2: history preserving an update on one or more attributes that weremarked as SCD2
will be added as new record and previous record will bemarked as not active.

l Design Fact tables
l Definemeasures

l Define granularity

l Define Dimensional Intersection Points
l Identify Fact to Dimension Links

Note: The IDE tool is used only for designing Fact and Dimension tables and their intersection
points.
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This section includes the following topics:

UI Description

Content Extension Guide for XS IDE Version 9.50

HP IT Executive Scorecard (9.50) Page 16 of 117



Discover Data Evidence
It is necessary to understand and be familiar with the new data you want to develop. When there is a
new source system involved, youmust first understand how the data from the source appears and
operates.

Tasks

Discover data evidence

Data Evidence can be discovered as follows:

1. Understand how to extract the data.
2. Take sample files extracted from the source.
3. Examine the different fields that this source provides: It is important to recognize the fields and

data that come from the source and to define the names of the fields as the source tables.
4. Define and plan in advance which extractors provide data for specific entities.
5. Understand variety, different lists of values, and end-cases.
6. Observe data behavior over time:

a. Understand what happens with data across time – is it the same file, only different dates?
b. Sizes of rows and volumes by types of customers.
c. Identify how this data correlates with existing data in the DataWarehouse.

At the end you should have a good sense of what this data looks like and how to develop
extraction code for it.

7. Identify:
a. What is the required data to be available in the Target schema to support required KPIs.
b. What is the data that can come from the source (depending on technology).
c. Where do they meet in themiddle, so eventually we have the outcomes of the extracted data

and the DWH Target model.
d. For which columns do you want to preserve history.

After mapping between the Source and the Target, the design process is complete.
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Development

Modeling
This stage is done completely in the IDE tool.

The IDE tool has the following XS DWH definition:

l Target Entity is a Fact or Dimension.
Entity name along with column names is defined according to the Star-Schema Architecture.

l Integration Entity is the source table representation.
Entity name along with column names and data types is defined according to source table design.

l Source Entity is the actual and accurate representation of an entity to be extracted from the source.
It describes how and what data is extracted from the source. It is generated automatically according
to integration entity design however depending on the extractor being used it may require some
changes as the automatic generation is targeted for the DB extractor only.

l Transformation Entity is the logical representation of all the transformations that are performed by
the DWH during the data processing. It’s the accurate representation of the Target Entity.

l Column Mapping - Source to target columnmapping
Themodeling approach:

Content Extension Guide for XS IDE Version 9.50

HP IT Executive Scorecard (9.50) Page 18 of 117



The SolutionModeling Highlights:

l Different functions are collaborating on samemodels simultaneously until reaching a final version.
l Actually serves as a high-level DB Studio + ETL tool. No need to touch the DB directly.
l 95% of the solution is defined by this high-level modeling.

DWH Content Development
This stage is the final stage of the content development on DataWarehouse side. The outcome of this
step is the ready-to-be-distributed Product Content Pack (iCP) and the delta artifacts for the Core
content pack.

TheProduct Content Pack (iCP) is the set of the artifacts that describe the data flows and data
transformations for the logical entities. The iCP belongs to one source product only (e.g. AM, PPM,
SM) and contains themetadata of:

l Source Content Packs
l The content packs that contain all source entities metadata

l The separate source content pack exists for each product version and the type of extractor used

l Integration Content Pack
l Contains the Integration Entities metadata

l Unlike Source entities, the integration entity is not dependent on the product version and
extractor type thereforemultiple source entities aremapped to the one integration entity.

l Column Mapping
l Contains themetadata of the columnmappings between the Integration entity and the Target
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entity.

TheCore Content pack contains themetadata for all the target entities and the intersections between
them and is the basic content pack for the DataWarehouse. It is deployed automatically during the XS
configuration.

DWH Content Development includes the following steps:

l Generate & Load DWH Artifacts
l Generate ETL codes fromModels

l Create New Content Pack

l Generate Physical Models

l Load BODS Artifacts

l Enrich ETL (BODS)
l Modify Delta-load Criteria

l Apply Specific Data-Processing & transformation Logic

l Set Consolidation Definitions

l Packaging and testing
l Export Artifacts to create Deployable Content Pack

l Running the ETL and verifying operation and correctness
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Content Packs and Data Modeling

Content packs contain all the artifacts needed to connect to the relevant data source and gather data
from that data source. Themapping between the raw data from the data source and the target database
in the DataWarehouse is included in the ETL.

Learn More

Content Pack contents

Content Packs include:

l The definition of the datamodel used for the connection.
l The type of data gathered from the data source.
l The ETL definitions.
l The definition files.
l The configuration files.
l The scripts that help build and define the DataWarehouse.
Content Pack Types

l Target Content Pack. Responsible for the transfer of data from consolidation to the target
database. The Target CP defines the content of the DataWarehouse as well as the look of the target
tables.

l Integrated Content Pack (i-CP). The i-CPs are responsible for bringing the data from the specific
data sources and transforming it into the consolidation level. From there, the Target CP transfers the
data to the target. The i-CPs integrate the information from the source, using the DWH schema and
loading process in order for the data to be brought to the target tables.

Content Pack directories

Content Packs contain the following directories:

l ABC: Contains files that define the ETL stream, and the general flow of steps of SAP
BusinessObjects Data Services jobs. The files list the order of the steps as well as the link between
the parent and child steps. These files are necessary if you have to add a step to the ETL process.

l Custom: Contains SQL scripts that are not part of the standard ETL processes. For example, if you
want to include a staging table that will help the ETL, the script is placed in the Custom directory.

l Data Model: Contains the xml files that define the target schema.
l ETL: Contains the jobs and workflows of the ETL and defines how data goes through the processes.
l cp_manifest.properties: Themanifest file provides additional information to the Content Pack to
allow the system to perform sets of validations.

l dw_app.properties
l dw_app.xml: Files that are created automatically when you add a new CP.
Data Model Types
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Datamodels describe the source, extraction, consolidation, and target components for a single entity:

l Target Entity. Fact orDimension: Entity name and column names defined according to the Star-
Schema architecture.

l Source Entity. The actual representation of an entity extracted from the source. Generated
automatically according to the integration entity design.

l Integration Entity. Entity name, column names, and data types defined according to source table
design.

l Column Mapping. Source to Target columnmapping.
Logical Data Models

DWH supports the following types of logical datamodels:

l Target Data Models:
l Target Model – Dimension or Fact. The target datamodels describe the format of the data that
produces business intelligence analytics. The instantiated datamodels are dimension, fact, and
hierarchy tables.

l i-CP Data Models:
l Extraction Model. ETL processes obtain the data in native format and stages it in intermediate
tables that conform to the extraction datamodel for that entity. Extraction also validates the data
to ensure that it is usable.

l Source Model. The source entity models represent the design of DII (Data Integration Interface).

Physical Data Models

DWH logical DataModels generatemultiple physical tables that support the ETL processing logic.

l Source entity models. The source entity models are the data produced by an external application.
Used for a specific version of the product, for example ALM 10/MSSQL, ALM 11Oracle.

l Extraction models. ETL processes obtain the data in native format and stage it in intermediate
tables that conform to the extraction datamodel for that entity. Extraction also validates the data to
ensure that it is usable.

l Consolidation models. Consolidationmodels transform the data further by merging extracted data
from diverse sources into meaningful data required by applications.

l Target models. The target models describe the final version of the data that adheres to the design
required by applications.

Datamodels describe the source and extraction format so that the data warehouse can consume this
data and integrate it into a common view that you can use to populate comprehensive business
intelligence reports and dashboards.

Each table contains both designed columns and static columns, also known as metadata columns, so
that the administrator can have the visibility of ETL processing over the entity’s data.

Data Warehouse Internal Fields
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The following are the internal DataWarehouse fields, in addition to those in the IDE, that are added to
themodel.

Field Name Prefixes Description

MD_BATCH_ID ETL stream ID displayed on all Physical Models.

MD_PROCESS_ID ETL Process ID running the specific job.

MD_DURABLE_KEY Entity’s unique identifier populated with MD_QUALIFIER which should be
considered as the identifier to consolidate records.

Displayed only in Consolidation Physical Models

MD_ENTERPRISE_
KEY

Entity’s unique identifier in the DWH system.

Displayed only in Target Physical Models

MD_BUSINESS_KEY Entity’s unique key as it comes from the source systems.

Displayed only in Target and Extraction Physical Models

MD_TRANSLASTIND Indicator whether the line is the last transaction of a specific MD_
ENTERPRISE_KEY.

Displayed only in Target Physical Models

MD_
ACTIVESTATUSIND

Indicator whether the line is active (simulates delete operation).

Displayed only in Target Physical Models

MD_
TRANSENDDATE

Transaction end date.

Displayed only in Target Physical Models

MD_DELETEDDATE Delete date (date record was marked as inactive).

Displayed only in Target Physical Models

MD_CREATEDDATE Date record was created.

Displayed only in Target Physical Models

MD_LASTMODDATE Date record was last modified and updated.

Displayed only in Target Physical Models

MD_FLAG Flag that indicates whether row is new, updated, or requires a delete.

Displayed only in Consolidations and Extractions Physical Models

MD_PF_FLAG Flag that indicates whether row is pre-filled or not.

Displayed only in Extractions Physical Models

MD_QUALIFIER Unique identifier of an Entity across all Sources, that allows consolidations
(like “Consolidation Rule”).

Example “NODE” entity qualifier is FQDN Node name.
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Field Name Prefixes Description

MD_CP_ID Source instance ID

Application Content Development
This stage implies creating the end-user artifacts based on the target datamodel that was developed
above.

It has the following steps:

l Generate Interface
l Create XS views (If Needed)

l Serves for normalizing the data for the KPI modeling purposes and filtering the unnecessary
DWH metadata fields.

l -Create Business Contexts
l Based on XS Views or Target Tables

l Similar to the Star-Scheme usually includes one fact entity which context is based on and the
multiple dimension entities linked to the fact.

l Create Artifacts
l KPIs

l Metrics

l Webi Reports

l Xcelsius Reports

l Calculate and Verify
l RunCalculation Engine

l Check validity

l Packaging
l Export Artifacts to create distributable Content Acceleration Pack

Content Extension Best Practices
There is set of best-practices and guidelines for creating customization tracks

l Do not modify the OOTB entities
l This includes avoiding linking the custom dimensions to the OOTB entities

l Use the Target Extension link from the custom entity to the OOTB entity instead.

Content Extension Guide for XS IDE Version 9.50

HP IT Executive Scorecard (9.50) Page 24 of 117



l Use the _CSTM suffix when naming the custom entities.
l Generate the ETL artifacts using the Custom container.
l Do not modify OOTB XS views, Business Contexts, BOUniverses andWebi Reports
Enforcing those guidelines will guarantee that the solution will never be overridden in the future and be
upgradable

Content Extension Rules
This section includes a set of best-practices and guidelines for creating customization tracks.

l Do not modify the OOTB entities:
l Avoidmodifying:

o Any existing files in any OOTB Content Pack directories.
o Any existing OOTB BODS workflows.
o Any existing OOTB engineercontext diagram and architectcontext diagram in the IDE.

l Avoid linking the custom dimensions to the OOTB entities.

Note: Instead of linking the custom dimensions to the OOTB entities, use the Target
Extension link from the custom entity to the OOTB entity.

l Use the _CSTM suffix when naming the custom entities.
l Generate the ETL artifacts using the Custom container.
l Do not modify OOTB XS views, Business Contexts, BOUniverses, CAPs, andWebi Reports.
Enforcing those guidelines will guarantee that the solution will never be overridden in the future and be
upgradable.

XS IDE User Interface Overview
The XS IDE is the Eclipse based plug-in that offers the visual tools for modeling the DWH entities and
creating the distributable XS content packs.

The IDE UI consists of three parts:

1) Package Explorer

2) Data Source Browser

3) Diagram Editor
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IDE Main Page
The IDE main page enables you to create Designers for the purpose of extending content to entities.
The following describes the IDE main page and icons.

The IDE Eclipse Main Page
The IDE requires basic knowledge of Eclipse and its capabilities. The following describes the IDE
layout and icons. SelectWindow > Show View to add to and change the view of the various tabs and
areas.

Note: It is recommended to select the IDE Perspective by clicking .

The IDE perspective contains all of the relevant buttons, areas, and functionality for
working in the IDE.

IDE Workspace: Main area where all IDE functions are located.
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Package Explorer A list of all of the available loaded Content Packs and Designer
diagrams.

Canvas Displays model diagram.

Problems Displays validation errors and warnings.

Properties Displays property tabs according to the selected entity in the Designer.

Error Log Reports system errors.

Data Source Explorer Enables you to connect to a specific data source and browse the
database.

ETL Generation. Appears when a designer is open in the canvas. Click
to perform the ETL process and generate the artifacts and create a new
Content Pack. For details, see "Generate Content" on page 80.

Save. Click to validate and save your mappings and configurations.

Report a Bug. Click to gather information for a bug report packaged in a
ZIP file.

Validate. Click tomanually perform validations on the Designer.

Perspective. Select to switch to recommended IDE perspective.

This perspective contains all of the relevant buttons, areas, and
functionality for working in the IDE.

IDE Icons

Icon Description

Indicates a Target entity.

Indicates an Integration entity.

Indicates a Source entity.

Indicates a Target extension entity.

Indicates a Integration entity column.
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Icon Description

Indicates a Fact entity column.

Indicates a Dimension entity column.

Indicates an association between Fact and Dimension entities.

Indicates an association between Dimension entities.

Indicates a columnwhich exists both as a Fact and as a Dimension.

Indicates a consolidation column.

Warning that appears when you save a problematic change to amodel that might cause an
error at a later stage in the process. You can view the details by hovering over the icon on the
model or in the Problems tab.

Error that appears when there is a design problem with your model in a designer. For example,
the length of a column is too long. You can view the details by hovering over the icon on the
model or in the Problems tab. Right-click an error to check if Quick Fix has been enabled for
the problem. For details, see "Manage Validation" on page 68.

Package Explorer
The Package Explorer shows and allows importing\creating the content pack directories.

All the pieces of the DWH entities modeled in the IDE – target, integration and source entities - are
stored as themetadata in the core, integration and source content packs directories correspondingly as
the xml files.

There is one directory for the Core CP (cp-core), one integration content pack directory per product (cp-
<Product_Name>) andmultiple directories for the source content packs per product per version per
extractor type (cp_<Product_Name>_<Product_Version>_<Extractor_Type>).

There are also directories where the data flow and datamodel diagrams are stored (cp_<Product_
Name>_<engineer\architect>).
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All the OOTB content packs source directories are shipped with the IDE package and can be imported
into the Package Explorer for extension or reference.

Data Source Browser
The Data Source Browser allows connecting to the data sources or multiple kinds to be able to browse
the source structure and data for reference purposes as well as to create the DWH entity and the entity
diagram automatically based on the data sourcemetadata.

The currently supported data source types are:

l Databases
l Flat file sources (text files with the specific separators)

DiagramEditor
There are two types of diagrams in the IDE:

l Architect Target Designer
l Engineer Stream Designer
TheArchitect Target Designer is used for modeling the Target datamodel: the target entities and the
links between them.

The Designer refers to the Core CP directory – all the entities modeled in it are created as the xml files
in the Core CP directory once the Designer is saved.
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The entity is visualized as the table with the fields, it has the properties with entity type selections (fact
and\or dimension) and the set of fields attributes based on the entity type.

The designer has the Palette with the available actions:

l Entities
l New Target Entity – create a new target entity placeholder on the canvas

l Load Target Entity – load the existing target entity from the Core CP directory (cp-core)

l Target Column – add the column to the target entity

l Target Entities Relation
l Dimension to Dimension – create the intersection point between the dimensions.

l Fact to Dimension – create the intersection point between fact and dimension.

l Target Extension – create the reference between theOOTB and the custom entity that is created
as the extension.

Physically the link between the entities is presented as a FK column in the entity table that refers to the
record in the linked dimension table.

TheEngineer Scream Designer allows creating the data path from the source to the target entity.

The Designer works with the selected Source, Integration and Core CP so that the new\existing
entities are created\loaded in\from the specific source, integration or core CP directories.
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The usual approach is to load the Target Entity that was previously created in the Architect Target
Designer and create the new Source\Integration entities andmap the fields to the Target entity.

In rare cases when the Target Entity is not supposed to be linked to any other dimension entities, it can
be created directly in the Engineer Stream Designer.

The Integration Entity has the Properties where the columns data types and lengths of the fields should
be set as well as the Business Key, Last Modified and nullable columns should be selected.

The Source Entity has the Properties that are based on the DB query concept and where the extraction
attributes like Table\Join Condition, Where clause and the columns names\aliases and rules can be
defined.
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Upon the linkage of the Source Entity to the Integration entity the attributed are populated
automatically:

l The Integration Entity name is populated into Table Name field
l The Integration Entity columns are populated into the Columns fields.
Physically the Source Entity is saved as the source entity xml based on which the queries\calls to the
data source are built.

The Palette has the set of available actions:

l Target Entity
l New Target Entity

l Load Target Entity

l Target Column

l Integration Entity
l New Integration Entity

l Load Source Entity

l Integration Column

l Source Entity
l New Source Entity

l Load Source Entity

l Source to Integration Relation (the source entity columns are not modeled by inherited from the
Integration entity which the Source entity linked to)

l Transformation
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l ColumnMapping – create a direct mapping from the Integration Entity fields to the
Target\Transformation Entity fields.
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Architect Target Designer Tasks
The Architect Target Designer enables you to define a Target entity as well as link associations, or
extend an existing entity. Each Target entity in the Architect Target Designer contains columns of fact,
or dimension (or both) and associations to other Target entities.

Architect Target Designers can contain one or more Target entities. Usually each Architect Target
Designer includes several entities that are related to the same subject (Designer). Target entities can
be included in several Architect Target Designers.

The IDE supports the extension of a target entity by creating an association called Target Extension.
This enables you to extend an entity by adding to the new entity columns. Adding an extension enables
Fact extension and the ability to link a group of Dimensions specifically to the same group. You then
use the extension entity to make all associations and links.

Note: Make sure you have selected the IDE perspective before beginning to work on your designer
diagram.

Note: It is recommended to create a separate general project in the Package Explorer for the
Architect Target Designer files.

To access:

In the IDE main page,select File > New >Other > DWH IDE Wizards > Architect Target Designer.

Learn More

The Architect Target Designer enables the following:

l Create a new entity metadata which is translated into the Target model.
l Load an existing Target entity.
l Add columns which affect entity generation.
l Add associations between entities.

l Link a Fact to Dimension

l Link a Dimension to Dimension

l Link an entity to an extension

Tasks

This section includes:
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Create a new Architect Target Designer in the IDE

1. In the IDE main page, select File > New > Other > DWH IDE Wizards > Architect Target
Designer and click Next.

2. Select the parent directory and enter the file name for the Stream Designer diagram -make sure
you do not change the suffix of the file name - and click Next.

3. Select the relevant Target Content Pack directory and click Finish.

Define a new Target entity

1. In the Architect Target Designer, in the palette area, select New Target Entity and click on the
canvas.

2. Name the entity.
3. Add relevant columns to the entity.

4. Click Save.

Load an existing Target entity

1. In the Architect Target Designer, in the palette area, select Load Target Entity and click on the
canvas. The Resource Selector dialog box opens.

2. Expand the target directory and select an entity. The entity is displayed with all of the previously
added columns and dimensions.

3. Add relevant columns to the entity. You can then edit and configure columns in the Properties
view.

4. Click Save.

Extend a Target Entity:

1. In the Architect Target Designer, in the palette area, select Load Target Entity and click on the
canvas to load the target entity that you want to extend. The Resource Selector dialog box opens.

2. Expand the target directory and select an entity. The entity is displayed with all of the previously
added columns and dimensions.

3. Select New Target Entity and click on the canvas to add the entity which will be the target
extension.

4. Name the entity. If you are extending the Person entity, for example, you can enter PERSON_
CSTM.

5. In the Properties tab of the new entity, configure the entity Type (Fact orDimension). Must be the
same entity type as the base entity.

6. In the palette area, click Target Extension.
7. Drag the arrow from the new extending entity to the original loaded entity.
8. This relation creates an extension to the new entity. The new entity name is displayed as an
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extension in the original entity. You can add relevant columns and configure the extended entity as
necessary. Mapping is then done from the Integration to the Target extension.

Note:

l The extending and base targets are referred to as a single entity. Therefore, you can not
add a columnwith the sameColumn ID of one in the original base entity.

l When you add an extension, make sure that the Source and Target are from the same
type.

l Target Extensions can also be extended.

l The name of the extension is derived from the name of the extended entity and cannot be
changed.

Add a column

1. In the Architect Target Designer, in the palette area, select Target Column.
2. Click in the Column area of your entity and enter the Column ID in the text box.

The column is added to the entity. You can then edit and configure columns in the Properties view.

3. Click Save.

Link a Dimension to a Dimension

1. In the Architect Target Designer, in the palette area, click Dimension to Dimension.
2. Drag the arrow from aDimension to the Dimension you want it linked to.
3. The New Dimension to Dimension dialog box opens. The default name is displayed and can be

edited. This relation links a Dimension entity to another Dimension.

Note: If you link to an entity from an existing association, you can connect using the arrow
without naming the Associated Dimension.

The default Associated Dimension name is the Target entity.

4. Click Save.

Link a Fact to a Dimension

1. In the Architect Target Designer, in the palette area, click Fact to Dimension.
2. Drag the arrow from the Fact entity to the Dimension you want it linked to.
3. The New Fact to Dimension dialog box opens. The default name is displayed and can be edited.

This relation links a Fact entity to another Dimension.

Note: If you link to an entity from an existing association, you can connect using the arrow
without naming the associated Dimension.
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The default associated dimension name is the Target entity.

4. Click Save.

Extend custom ITFM Entities

1. In the Architect Target Designer, in the palette area, select Load Target Entity and click on the
canvas to load the target entity that you want to extend. The Resource Selector dialog box opens.

2. Expand the target directory and select either ACTUALCOST_CSTM or PLANNEDCOST_CSTM
(custom extended) entities. These two ITFM entities comeOOTB with custom extension entities
that can be further extended through the ACTUALCOST_CSTM or PLANNEDCOST_CSTM
entities.
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UI Description

Create Architect Target Designer

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Enter or select the parent
directory

Select the directory in which this Designer will be contained, from
the directory list.

File Name Enter a file name for your Designer diagram.
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Target Content Pack

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Target Content Pack Select or browse for the Target Content Pack directory.
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Architect Target Designer View

Palette Area

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI
Element Description

Entities Contains the following Target entity options:

l New Target Entity. Creates a new Target entity. Entity type can be defined in the
Properties tab. To view the Properties tab, right-click on the specific entity and click
Show Properties View.

l Load Target Entity. Opens the Resource Selector dialog box. Select the
relevant entity for your model.
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UI
Element Description

l Target Column. Adds columns to entities. Column properties, for example
column type, can be edited in the Properties tab.
Each added attribute impacts the relevant entity generations.

Target
Entities
Relation

Click a link to create connections for building themodel.

l Dimension to Dimension. Link from one Dimension to another Dimension. A
red arrow is displayed between the entities.

l Fact to Dimension. Link from a Fact to a Dimension. This type of relation
requires that the fact type was defined in the entity properties. A blue arrow is
displayed between the entities.

l Target Extension. Link from a new target entity to the base/original target entity.
A black arrow is displayed between the entities.
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Properties tab for Target entity and specific fields

To view the Properties tab, right-click on the specific entity and click Show Properties View.

You first configure the Target entity properties, and then the properties for each specific column.

UI Element Description

General tab Displays theEntity, Dimension and Fact attributes for the target entity.

General Target entity attributes:

l ID: The ID of the entity.
l Business Name: The complete business name.
l Description:Enter a description of the entity.
l Dimension/Fact Checkbox: Select one or both for the entity.
If you change the selection, a dialog opens, warning that youmay lose information
previously entered in the Columns tab.

Note: Make sure to select the required option connected to the relevant Fact or
Dimension column properties.

Columns
tab

Displays information for each column in the Target entity. Column property options
are displayed according to the entity selection of Fact or Dimension in the General
tab.

l ID. The ID of the entity.
l Business name. The complete business name.
l Description. Enter a description of the entity.
l Data Type. Varchar, Int 16, Int 32, Float, Localized Date Time
l Length. Only for Varchar data type. The length of a Varchar columnmust bemore
than 0 and less than 4000.

l Null Allowed. Select if the field can have the value NULL.
l SCD Type. Slowly Changing Dimension type can be either 1 or 2. Only for
Dimension.
SCD1: For update.
SCD2: For preserving history.

l Measure. Select only for Fact.
l Calculation Formula. The calculation of themeasure. (Optional)
l Summary. Select SUM,MIN,MAX, orAVG. (Optional)

Appearance
tab

Displays font and appearance information.

New Associated Dimension Dialog Box

When you link to an unlinked Dimension, the following dialog box opens.
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Edit an Associated Dimension name. The default is the Target entity name.
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Target Extension Entity

OOTB ITFM Custom Target Extension Entity
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Properties tab for Associated Dimensions

To view the Properties tab, right-click on the specific entity and click Show Properties View.

UI Element Description

Associations tab Displays Dimension association information:

l ID. The ID of the entity.
l Business Name. The complete business name.
l Description. Enter a description of the entity.
l Type. Select Dimension, Fact, orBoth.
l SCD Type. For Dimension only.
l From Target. The Target entity.
l To Target. The Associated Dimension

Appearance tab Displays font and appearance information.
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Engineer StreamDesigner Tasks
The Engineer Stream Designer enables you to define the integrations and how they are transformed
and connected. This view defines themapping relations for the entity from the source to the target. You
can create new integrations based on graphical diagrams, using the Engineer Stream Designer in the
IDE tool.

Note: Make sure you have selected the IDE perspective before beginning to work on your designer
diagram.

To access:

In the IDE main page, select File > New > Other > DWH IDE Wizards > Engineer Stream
Designer.

Learn More

The Engineer Stream Designer enables you to extend and add content from the Integration and Source
Content Packs into the target model. Using a new or existing Target entity, you can add new or existing
content from the Integration and Source entities. You then perform transformation and Source
Integrationmapping for new and pre-loaded entities. The Source, Integration and Target entities are
mapped using the TransformationMapping connector, which creates a new mapping entity. All further
mapping is done to the new entity in order to complete the Target model.

Note: All Source entities must be connected to an Integration entity.

Entities in the Engineer Stream Designer aremapped as follows:

l Source Entity:Mapping to the correct source, meaning the version the data is extracted from.
l Integration Entity:Contains themapping of all fields.
l Target Entity:Several consolidation entities can be consolidated into one entity.
It is recommended tomap from the Source to the Target.

Source Extractors

OOTB set of existing supported extractors are:

l Generic Extractors
l DB Extractor: Supports MSSQL, Oracle andMySQL databases.

l File Extractor: Supports general CSV file.

l Source Specific Extractor
l BSM API Extractor:Supporting both GDE and REST calls.

l DP CLI Extractor
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l SA SDK Extractor

l NNM Optimized file Extractor:Holds mass volumes of NNM files.

Connecting to the integration:
ETLGen templates in the back-end generate integration templates which utilize File Based
Integration (FBI). Load the Sourcemetadata to the IDE and thenmap it to the correct consolidation
entity in the relevant fields. To create a custom FBI extractor, see the FBI Extractor SDK Guide.

Important Information

Note: Creating new Target entities with Associated Dimensions can only be done in the Architect
Target Designer.

Tasks

This section includes:

Create a new Engineer Stream Designer in the IDE

1. In the IDE main page, select File > New > Other > DWH IDE Wizards > Engineer Stream
Designer and click Next.

2. Enter or select the parent directory and enter the file name for the Engineer Stream Designer
diagram -make sure you do not change the suffix of the file name - and click Next.

3. Select the Target, Integration, and Source Content Pack directories and click Finish.

Define a new Target entity

1. In the Engineer Stream Designer, in the palette area, select New Target Entity and click on the
canvas.

2. Name the entity.
3. Add relevant columns to the entity.

4. Click Save.

Load an existing Target entity

1. In the Engineer Stream Designer, in the palette area, select Load Target Entity and click on the
canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with all of the previously added columns and dimensions.

3. Click Save.
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Define a new integration entity

1. In the Stream Designer, in the palette area, select New Integration Entity in the Integration
section and click on the canvas. An integration entity is displayed.

2. Enter a name. The name can be up to 44 characters. An Integration entity is created.
3. Click Integration Column to add a column to the entity.
4. Perform mapping if required.

5. Click Save.

Load an existing integration entity

1. In the Stream Designer, in the palette area, select Load Integration Entity in the Integration
section and click on the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with all of the previously addedmappings.

Define a new source entity

1. In the Engineer Stream Designer, in the palette area, select New Source Entity in the Source
section and click on the canvas. A Source entity is displayed.

2. Click Source-Integration Relation and drag the display arrow from the Source entity to an
Integration entity. All columns from the Integration entity are copied to the Source entity with
default values.

3. Click Save.

Note: The Source-Integration Relation tool only enables you to link Source entities to
Integration entities of the same product (content pack). For example, a Source entity from cp-
bsm-9.01-bsm can only be linked to Integration entities from cp-bsm and not cp-ppm.

Load an existing source entity

1. In the Engineer Stream Designer , in the palette area, select Load Source Entity in the Source
section and click on the canvas. The Resource Selector dialog box opens.

2. Select an entity. The entity is displayed with its mapped integration entity.

Add a column

1. In the Engineer Stream Designer, in the palette area, select Target Column or Integration
Column.

2. Click in the Column area of your entity and enter the Column ID in the text box.
The column is added to the entity.

3. Click Save.
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Note: Source data is replicated from the integration entity. If you add or delete columns from the
Integration, however, it is not automatically done in the Source.

To add: Once you have added the column, delete themapping link and re-map from the Source to
Integration.

To delete: Right-click the deleted column, delete themapping link and re-map from the Source to
Integration.

Alternatively, you can use theQuick Fix mechanism on the error that appears in the Problems tab.
For details, see "Manage Validation" on page 68.

Map from the Integration to Target

Once you have added columns to the Integration entity you can perform SSI mapping.

1. In the Engineer Stream Designer, in the palette area, click Column Mapping in the Relations
section tomap the Integration to the Target entity.

2. Drag the arrow from the Integration column to the Target column.
3. After you have performed the first SSI mapping, a transformation SSI entity is created to which

you can perform further mapping. Any integration entity from the sameCP that should bemapped
to this Target, must bemapped to the transformation entity.

4. Click Save.

Note: If an Integration column is already mapped to a Target column, you cannot perform
further mapping from the sameContent Pack.

Two Integration entity columns from the sameContent Pack cannot bemapped to the same
Target entity column.
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UI Description

Engineer Stream Designer View

Palette Area

UI Element Description

Target Entity
l New Target Entity. Select to display a new Target entity.

l Load Target Entity. Opens the Resource Selector dialog box. Select the
relevant entity for your model.
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UI Element Description

l Target Column. Adds columns to entities. Column properties, for example
column type, can be edited in the Properties tab.
Each added attribute impacts the relevant entity generations.

Integration
Entity

Contains the following Integration entity options:

l New Integration Entity. Select to display a new Integration entity.

l Load Integration Entity. Opens the Resource Selector dialog box. Select
the relevant entity for your model.
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UI Element Description

l Integration Column. Adds columns to entities. Column properties, for
example column type, can be edited in the Properties tab.
Each added attribute impacts the relevant entity generations.

Source Entity Contains the following Source entity options:

l New Source Entity. Select to display a new Source entity.

l Load Source Entity. Opens the Resource Selector dialog box.Select the
relevant entity for your model.

l Source to Integration Relation. The Sourcemust bemapped to the
Integration in order to map to the Target. A green arrow is displayed between
the entities.

Transformation Click tomap the displayed entities.

l Column Mapping.Mapping between the Integration and Target columns.
First timemapping is done from the Integration column to the Target column. A
black arrow is displayed between the entities.
First-timemapping creates a new entity for Transformation. Subsequent
mappings are done to the new Transformation entity.
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Properties tab for Integration

To view the Properties tab, right-click on the specific entity and click Show Properties View.

Note: Properties data is replicated in the Integration and Source columns. If you add or delete
columns from the Integration, however, it is not automatically done in the Source.

To add: Once you have added the column in the properties tab, delete themapping link and re-map
from the Source to Integration.

To delete: Right-click the deleted column, delete themapping link and re-map from the Source to
Integration.

UI Element Description

General tab Displays theGeneral entity attributes.

Columns tab Displays column information:

l ID. The ID of the column. It is taken fro themapped integration column and is
read-only.

l Business name. The complete business name.
l Description. Enter a description of the entity.
l Data Type. Varchar, Int 16, Int 32, Float, Localized Date Time
l Length. Only for Varchar data type. The length of a Varchar columnmust be
more than 0 and less than 4000.

l Null Allowed. Select if the field can have the value NULL. If you specify a
Business Key, at least one of the columns must not Null Allowed.

l Business Key. Primary key of the Integration field order. Select a number for
the order of columns for placement. When no number has been assigned, you
can only select 1. Subsequently you can assign any number to a column. If
you change a number, all other assigned columns are automatically shifted
down a spot in the order.

Example If you change the Business Key of a column to 1, the one that
was specified previously as 1 becomes 2.

l Last Modified. The last date that the source has been changed. Select the
button if you want a query from a certain date and not all possible data.

Properties tab for Source

To view the Properties tab, right-click on the specific entity and click Show Properties View.

UI
Element Description

General
tab

General attributes:
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UI
Element Description

l ID. The entity ID.
l Content Pack. The Source Content Pack information.
Data Source SQL Clauses:

l Group by. The section in the SQLQuery for the aggregation.
l Table Name/Join Condition. Default is Integration entity name. If you change the
table name, youmust also change it in the columns. Enter the Join Condition for an
SQL query with join.

l Where.Where to extract for the SQL query for filtering data from the source.

Columns
tab

Displays column information. The Source entity receives all of the Integration entity
properties.

l ID. The ID of the column. It is taken fro themapped integration column and is read-
only.

l Type. Select Fixed, Direct, orRule. If you select Fixed, youmust enter a Fixed
Value. if you select Rule, youmust enter the Calculation Rule.

l Not Applicable.
l Table Name. Based on table name entered in the General tab. Relevant only if
Direct type is selected.

l Column Name. The field name. Must be what appears in the Source entity.
l Fixed Value. The fixed value of the column. Relevant only if Fixed type is selected.
l Calculation Rule. The calculation rule of the column. Relevant only if Rule type is
selected. The IDE does not support non UTF-8 characters in theCalculation Rule
field.

For details on the Properties for Target entities, see "Properties tab for Target entity and specific fields"
on page 42

For details on the Properties tab for Associated Dimensions, see "Properties tab for Associated
Dimensions" on page 45.

The DW Content menu
The DW Content menu has several actions (that are also duplicated on the Toolbar):

l Report a Bug (the workspace is exported to the zip archive and can be sent to Support for
investigation)

l Upgrade (applicable in case the entity was created in the previous IDE versions)
l Validate (check the opened diagrams for errors)
l ETLGen (The generation of the ETL based on the opened diagram)
l BODS Export (the advanced ETL transformations that are done in BODS can be exported into the
deployable content pack)
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Obviously themost usable action is the ETLGen.

By clicking this menu item\tool bar button the ETLGenerator dialog is opened.

Since the ETL artifacts are different in different XS versions, it is important to select the correct XS
version.

The Content Type can be eitherXS Content orCustom Content. Only the OOTB content is generated
using theXS Content type, so whenever the OOTB content is extended or the new content is created
using the Custom Content type should be selected. Physically depending on this setting the BODS
entities workflows are placed to either Generic or Custom container.

Selecting the Generate Content Pack check-box allows generating the full content pack directory
structure. It is applicable whenever the new content pack is selected. In case of the extension of the
existing content packs, the generation of the CP directory structure is not required because only the
delta artifacts are generated andmerged to the existing content pack directory in the \<HP-
XS>\agora\ContentPacks directory.

After specifying the settings above the location for the generated ETL artifacts should be selected.

The ETL artifacts are generated only for the Designer in context of which the ETLGenerator dialog in
opened.

The two directories are generated: Core – the target entity artifacts, and <Product_Name> - the source
entity, integration entity andmappings artifacts. These two directories should be then copied into the
\<HP-XS>\agora\ContentPacks directory. If the new content pack is created, it should be registered
in DWH using the dw_cp_register.bat utility in order to become available on the Data Source
Management UI.

Common Extension Scenarios
There are several most common extension scenarios:

1. Extension of the existing entity in the existing content pack
2. Extraction of the new entity in the existing content pack
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3. Populating the existing entity from the new source
4. Extraction of the new entity from the new source

Extension of the existing entity in the existing Content
Pack
In this scenario themain goal is to addmore fields of the existing entity.

The approach is the following:

1. Use the existing Integration and Source (the required product version) content packs.
2. Model the new target entity and link it to the OOTB target entities using the Target Extension link.

Note: Make sure the name of the new entity includes the suffix _CSTM.

3. Model the new Integration and Source entity
4. Generate the ETLwithout creating the new content pack (just the delta is generated).

Note: Make sure the content type is “custom” when generating the ETL.

a. Only new entity artifacts are used (not the whole content pack) for both Core and Product
content packs andmerged with existing CP directories in the XS content packs directory.

Extraction of a new entity in an existing Content Pack
The purpose is to bring the new entity from the data source which already has the OOTB integration
with XS.

The approach is similar to the previous scenario; the only difference is that instead of the Target
Extension link the Fact to Dimension or Dimension to Dimension link is used for linking the new entity
with the OOTB entities.

Note:

l Make sure the name of the new entity includes the suffix _CSTM.
l Make sure the content type is “custom” when generating the ETL.

Populating an existing entity from a new data source
In case when the customer does has the source systems that XS does not have the OOTB integration
with, but does have the necessary target entities with all the necessary fields, the approach for
developing the integration is as follows:

1. Create new Integration and Source content packs.
2. Use the existing Target entity
3. Create new Integration and Source entities.
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Note: Make sure the name of the new entity includes the suffix _CSTM.

4. Generate the ETLwith the Generate Content Pack feature in order to create the new CP.
a. Only the Product Content Pack artifacts are used (the Core CP has the entity already) and are

copied to the XS content packs directory as a new directory.

Note: Make sure the content type is “custom” when generating the ETL.

5. Register the new CP in XS.

Extracting a new entity from a new source
There are cases when XS does not provide either the OOTB CPs or the suitable target entities that
could fulfill the integration requirements. In this case themodeling of the all pieces is required.

1. Model the target entities and the references between them
2. Create new Source and Integration Content Packs

Note: Make sure the name of the new entity includes the suffix _CSTM.

3. Model new Integration and Source entities.
4. Generate the ETLwith the Generate Content Pack feature in order to create the new CP.

a. The product CP directory is copied to XS content packs directory as a new directory
b. The Core CP directory (delta) is merged with the existing Core directory in the XS content

packs directory.

Note: Make sure the content type is “custom” when generating the ETL.

5. Register the new CP in XS.
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Import Existing Content
When you extend your existing content using the IDE, youmust import the relevant content packs you
want to work with.

Note: Youmust import the Target Content Pack (cp-core) in order to extend or create content in
the IDE.

Tasks
Import existing content

1. Navigate to File > Import > General > Existing Projects into workspace and click Next.
2. Browse for the cp-core directory and click OK, click Finish to import the project.
3. Import all of the relevant content packs you need to work with.
4. Proceed to creating the Designers.
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Define New Content Pack Project
The IDE comes with out of the box Content Packs which you can import to add and extend content.
You can also create projects based on data from new content directories, which youmust manually add
and define.

Note: Youmust import the Target Content Pack (cp-core) in order to extend or create content in
the IDE.

To access:

In the IDE main page, select File > New > Other > DWH IDE Wizards > Content Pack.

Tasks

Create new projects from content directories
To create new projects from content directories:

1. Select File > New > Other > DWH IDE > Content Pack.
2. Select the type of project: Source or Integration.
3. Enter the relevant details for the project and click Next.
4. Select the relevant Content Pack reference for the project:

l For new Integration CP select the Target Content Pack for the project.

l For new Source CP select the Integration Content Pack for the project.

5. Click Finish.
6. Proceed with defining the Architect Target and Engineer Stream Designer projects. For details,

see "Architect Target Designer Tasks" on page 34 and "Engineer Stream Designer Tasks" on
page 46.
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UI Description
Integration Project

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Product Name Name of the source product.

Make sure that after you define the product name, you can view the file under the
Integration project icp.dwmodelappintegration file.

Use Default
Location

Select to use the displayed location for your new project.

Location Browse to the location of the content directory.
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UI Element Description

Add project to
working sets

Select to add this project to the current set of projects.

Working Sets Select new working sets.

Target Content Pack Reference

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Referenced projects Select the Target Content pack for the new Integration project.
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Source Project

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Product Name Name of the source product.

Make sure that after you define the product name, you can view the file under
the Source project scp.dwmodelappsource file.

Version Enter the data source version.

Product Type Enter the data source type.

Use Default
Location

Select to use the displayed location for your new project.

Location Browse to the location of the content directory.

Add project to Select to add this project to the current set of projects.
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UI Element Description

working sets

Working Sets Select new working sets.

Integration Content Pack Reference

User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

Referenced projects Select the Integration Content pack for the new Source project.
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Define the Target Model
Before working with a specific designer, you should define the Target model and the related
associations andmappings. The Target model describes the final version of the data that adheres to
the design required by applications. Each table in themodel contains both designed columns and static
columns, which comprises themetadata, so that the administrator can have the visibility of ETL
processing over the entity’s data.

Target Model – Dimension or Fact: The target datamodels describe the format of the data that
produces business intelligence analytics. The instantiated datamodels are dimension, fact, and
hierarchy tables.

In the Architect Target Designer you define the target model containing the entities and links between
them.
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Extend the Period Entity
The Period target entity requires special mapping requirements in the IDE. The entity contains time and
date relatedmapping and can only connect to date related sources and dimensions, for example
START_TIME.

When you connect to a data source that has a Period entity, the data source consistently changes
depending on configurations. Therefore you can only map to date-related entities and dimensions.
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Delete an Entity Permanently
The IDE enables you to permanently delete an entity that is not needed or supported, from the file
system. Make sure that no other entity contains any reference to the deleted entity.

Note:When you right-click a selected entity and click Delete From Model, the entity is only
removed from the current designer and not from the file system.

Tasks

Permanently delete an entity

To permanently delete an entity:

1. Delete the relevant entity from the canvas.
2. In the Package Explorer, expand the content pack that contains the entity you want to delete, for

example cp-sa.
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3. Delete the actual entity, for examplePOLICY, from the Package Explorer.
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Manage Validation
The IDE performs validations on all Designers and entities created in the Designers. After you save
your changes, you can view the errors and warnings that occurred during content development. You
can perform amanual validation or use the Quick Fix solution tomake the required fixes for validation.

Note: All validations are performed only after you have saved your changes to the Designers.

To access:

Click theProblems tab.

Tasks
This section includes the following topics:

• View the errors and warnings that occurred during content development 68
• Manually perform validation 69
• Quick Fix 69
• Validation Table 70

View the errors and warnings that occurred during
content development
After you save your changes, click theProblems tab, below, to view the errors and warnings that
occurred during content development.
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Manually perform validation
Additionally, you canmanually perform validations on all Designers and fix relevant errors and
warnings.

1. To activate, click in the toolbar, or select DW Content > Validate.
2. During the validation process, a Progress Information dialog box appears specifying the current

validated designer and its progress.

In case of an unreadable designer, an error dialog appears, listing the problem designer diagrams.

3. Click Cancel to cancel the validation process.
All validations are performed only after you have saved your changes to the Designers.

Quick Fix
The validation process also includes aQuick Fix validation which provides recommendations for
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solutions for validation problems displayed in the Problems tab.

To use theQuick Fix option:

1. In theProblems tab, under theWarnings orErrors list, right-click a warning or error and select
Quick Fix to open theQuick Fix dialog box.

2. Select the fix for the specific warning and click Finish.

3. Click Save and the error is removed.

Reference

Validation Table
Make sure all entities have been configured properly according to the following validations. An error or
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warning appears in the Problems tab once you havemade the problematic change, and saved it. Note
the validations that have the Quick Fix option available.

Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID> column
<Column ID> - id
length is greater
than allowed

Integration
<Integration ID>
column <Column
ID>:- id length is
greater than
allowed

Length of column names
(including system suffix)

Up to 60
characters

Up to 60
characters

Up to 60
characters

Target <Target
ID>: id length is
greater than 50
characters

Integration
<Integration ID>
id length is greater
than 44
characters

Length of entity names
(including system suffix)

Up to 60
characters

Up to 44
characters

Up to 50
characters

Sample errors:

Target <Target
ID>: 'Business
Name' field
contains
backslash (\)
character

Integration
<Integration ID>
'Description' field
contains
backslash (\)
character

Source <Source
ID>: 'Group By'
field contains
backslash (\)
character

Backslash ( \) is not permitted
in any field text.

ü ü ü ü

Target <Target Entity names and column ü ü ü ü

Content Extension Guide for XS IDE Version 9.50

HP IT Executive Scorecard (9.50) Page 71 of 117



Error Text Validation Source Integration Target
Quick
Fix

ID> column
<Column ID> id
attribute violates
DW Platform
reserved prefixes:
starts with non
alphabetic
character

Integration
<Integration ID>
column <Column
ID>: id attribute
violates DW
Platform reserved
prefixes: starts
with non
alphabetic
character

names must start with
alphabetic characters.

Target entity is
invalid. File
containing the
metadata was
deleted

Integration entity
is invalid. File
containing the
metadata was
deleted

Source entity is
invalid. File
containing the
metadata was
deleted

Make sure an entity deleted
from the file system is also
deleted from the designer
diagram.

ü ü ü

Target <Target
ID> column
<Column ID>
DataType is not
defined

Make sure Data Type is
defined for all Target columns.

ü

Target <Target
ID>: no column is
defined as SCD
for dimension
entity

Make sure when a Target
entity is defined as a
Dimension that SCD Type is
defined for at least one column.

ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID>: no column is
defined as
measure for fact
entity

Make sure when a Target
entity is defined as a Fact that
Measure is selected for at
least one column.

ü ü

Target <Target
ID>: not defined
as FACT or
DIMENSION

Make sure a Target entity is
defined as a Fact, or
Dimension, or both. The entity
type cannot be left unselected.

ü

Target <Target
ID>: no column is
defined as SCD
for dimension
entity

Target <Target
ID>: no column is
defined as
measure for fact
entity

Make sure that when a Target
entity is defined as a
Dimension and a Fact, that at
least one column in the entity
is defined accordingly for each
type.

Note: If the Target entity
contains only associated
Dimensions, this
validation is not
performed.

ü ü

Target <Target
ID>: Invalid target
extension. Target
type doesn't
match

Make sure that the data type in
the extended entity equals the
type of the base entity.

ü

Target <Target
ID> column
<Column ID> - id
is not unique in
target extension

Make sure column or
Associated Dimension ID is
unique in the Target extension

ü

Target <Target
ID>: Target
extension
contains loop

Make sure Target extension
does not contain a loop,
meaning the extension of a
base entity can not also have
the base entity as an
extension. That would place
the entities in a loop with each
other.

ü

Target <Target
ID> column

Integration names and in the
columns first character must
be a letter:

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

<Column ID> id
attribute violates
DW Platform
reserved prefixes:
starts with non
alphabetic
character

[a-z][A-Z].

Target <Target
ID>: id attribute
violates DB
character
constraints (a-z
A-Z 0-9 $ # _)

Target <Target
ID> Associated
Dimension
<Associated
Dimension ID> id
attribute violates
DB character
constraints (a-z
A-Z 0-9 $ # _)

Target <Target
ID> column
<Column ID> id
attribute violates
DB character
constraints (a-z
A-Z 0-9 $ # _)

Integration
<Integration ID>
id attribute
violates DB
character
constraints (a-z
A-Z 0-9 $ # _)

Integration
<Integration ID>
column <Column
ID>: id attribute
violates DB
character
constraints (a-z
A-Z 0-9 $ # _)

Integration names and in the
columns next characters
should be a letter, a digit, or '_'
, '$', or '#'.

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Source <Source
ID> <Column
ID>: 'Column
Name' field
violates DB
character
constraints (a-z
A-Z 0-9 $ # _)

Target <Target
ID>: id attribute
violates DW
Platform reserved
prefixes: MD_ or
DI_

Target <Target
ID> Associated
Dimension
<Associated
Dimension ID> id
attribute violates
DW Platform
reserved prefixes:
MD_ or DI_"

Target <Target
ID> column
<Column ID> id
attribute violates
DW Platform
reserved prefixes:
MD_ or DI_

Integration
<Integration ID>id
attribute violates
DW Platform
reserved prefixes:
MD_ or DI_

Integration
<Integration ID>
column <Column
ID>: id attribute
violates DW
Platform reserved
prefixes: MD_ or
DI_

Integration names and in the
columns must not start with
one of the DW Platform
reserved prefixes: MD_ or DI_.

ü ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Integration
<Integration ID>
no business key
is defined

Integration
<Integration ID>
Business key
sequence is not
defined properly
(Doesn't start at 1
or numbers are
not sequential)

Make sure that the Business
Key is specified. In case of
more than one Business Key,
they must be in order (1, 2, 3)
without spaces in the
numbering.

ü

Integration
<Integration ID>
Business key
sequencemust
contain at least
one columnwhich
is not Nullable

Make sure Null Allowed is not
selected for at least one of the
Business Keys.

ü ü

Target <Target
ID> : No id is
defined for
column

Target <Target
ID> column
<Column ID> - id
is not unique

Integration
<Integration ID>
column <Column
ID>:- id is not
unique

Make sure that the column has
an ID and it is unique.

ü ü

Source <Source
ID> <Column
ID>: no value at
table name field

Source <Source
ID> <Column
ID>: no value at
db column name
field

If a Source column has Type
set as Direct, thenmake sure
Table Name and Column
Name are not empty.

ü
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Error Text Validation Source Integration Target
Quick
Fix

Source <Source
ID> <Column
ID>: no value at
fixed value field

If a Source column has Type
set as Fixed, thenmake sure
Fixed Value is not empty.

ü

Source <Source
ID> <Column
ID>: no value at
calculation rule
field

If a Source column has Type
set as Rule, thenmake sure
Calculation Rule is not empty.

ü

Source <Source
ID> <Column
ID>: 'Column
Name' field
contains
backslash (\)
character

Source <Source
ID> <Column
ID>: 'Column
Name' field
violates DB
character
constraints (a-z
A-Z 0-9 $ # _)

If a Source column has Type
set as Direct, thenmake sure
ColumnName does not
contain special characters.
This validation runs only if the
Product Type in the source
Content Pack is the database
type of either MSSQL, Oracle
or MySQL.

ü ü

Source <Source
ID> doesn't
include join
condition

Make sure that the Source
entity has a Join Condition and
Table Name specified.

ü

Source <Source
ID> contained in
<cp Name> is not
referencing to any
integration entity

Make sure that a Source entity
is mapped to an Integration
entity.

ü ü

Source <Source
ID>: columns are
not synchronized
with integration
entity columns

Make sure that the Source and
Integration entities are
synchronized.

ü ü

Integration
<Integration ID>
column <Column

Make sure all mapped
Integration columns are
mapped accordingly to the

ü
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Error Text Validation Source Integration Target
Quick
Fix

ID>: is not
mapped to target
column and data
type is undefined

Integration
<Integration ID>
column <Column
ID>: contains
invalid mapping

Target or have been assigned a
data type.

Target <Target
ID> column
<Column ID> is
defined as
VARCHAR but
has no length

Integration
<Integration ID>
column <Column
ID>: is defined as
VARCHAR but
has no length

Make sure that the length of a
Varchar column is more than 0.

ü ü

Target <Target
ID> column
<Column ID> is
defined as
VARCHAR but
length is greater
than allowed
(4000)

Integration
<Integration ID>
column <Column
ID>: is defined as
VARCHAR but
length is greater
than allowed
(4000)

Make sure that the length of a
Varchar column is less than or
equal to 4000.

ü ü ü ü

No id is defined
for target entity

No id is defined
for integration
entity

Make sure each entity has an
ID defined.

ü ü ü
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Error Text Validation Source Integration Target
Quick
Fix

Target <Target
ID> column
<Column ID> the
id is a DB
reserved word

Integration
<Integration ID>
column <Column
ID>: the id is a
DB reserved word

Make sure the defined column
name does not contain a
reserved word. For details, see
MSDN Microsoft SQL Server
reserved keywords list.

ü ü ü
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Generate Content
The IDE can generate the relevant schemas and ETLs that are required for the integration.

The ETLGenerator generates the required artifacts based on themodeling in the previous steps. The
artifacts contain BODS workflows that are imported into the BODS repository as well as the data
models and XML files that are imported into the DataWarehousemetadata repository. Once the
metadata has been loaded, the schema generationmechanism performs the schema changes in the
target and the staging databases.

To access:

When a designer is open, the ETL button is displayed in the top right toolbar in the IDE workspace. If it
is not displayed, navigate toWindow > Customize Perspective andmake sureXS IDE is selected.

Click to begin the ETLGenerator.

Learn More
Content Pack Creation Tool

The Content Pack Creation Tool enables you to create a new Content Pack structure using existing
source content packs. This allows you to use the IDE to extend content as well as develop entirely new
Content Packs for use in the DataWarehouse and IT Executive Scorecard.

The ETLGenerator action is relevant to the selected designer. The ETL button is only displayed when a
designer is open.

Tasks

Create a new entity and a new Content Pack with the
ETL Generator
To create a new entity and a new Content Pack with the ETLGenerator:

1. Click in the toolbar on the top right of the IDE workspace to begin the ETLGenerator. The
ETLGenerator dialog box opens.
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2. In the dialog box:
l InXS ETL Version, select 10.00.

l InContent Type: select XS Content or Custom Content.

l Select theGenerate Content Pack check box if you are creating a new Content Pack (not
extending content). This creates a new content pack structure along with the generated ETL
files. This capability is only available when generating the ETL files in the Designer.

Note: TheGenerate Content Pack check box is not available when generating the ETL
files from the Architect Target Designer.

When you generate the ETL files from the Engineer Stream Designer, theGenerate
Content Pack check box is disabled if there are no source entities in the Engineer Stream
Designer.

l InDirectory, browse to the directory where you want the generated Content Pack to be placed.

3. Click OK. The process may take some time.
4. Proceed to package and deploy your content.
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Package and Deploy Content
After you have run the ETLGenerator and saved the Content Pack, youmust package your new or
extended content solution.

Tasks
This section includes the following topics:

• Package and deploy content 82
• Compact the BODS repository after each redeployment 83

Package and deploy content
Copy the generated files to the Content Packs directory on the DWH server. Use the automation tool to
deploy the changes in content.

l For Content Packs with added or extended entities:
l The Target CP is deployed when changes are added to the target schema:

i. Launch the command line window in administrator mode.
ii. Re-deploy the Target CP by running the command: dw_ds_automation.bat -task

Redeploy -cp Core.

l The Integration CP is deployed when changes made to an Integration or Source entity:
i. In the XS user interface, activate the i-CP.
ii. Launch the command line window in administrator mode.
iii. Re-deploy the i-CP by running the command dw_ds_automation.bat -task Redeploy -cp

<CP_NAME>.

l The Integration CP is not deployed when changes made to an Integration or Source entity:
o i activate the i-CP at XS UI

l For new Integrated Content Packs:Make sure your new CP is packaged in the correct directory
structure by selecting theGenerate Content Pack checkbox in the ETLGenerator, and then
copying it to the ContentPacks directory in your DWH installation.
a. Launch the command line window in administrator mode.
b. Register the new Content Pack: dw_cp_register.bat -name <CP_NAME> -type integration.
c. Activate the new Content pack in the XS user interface or activate the new Content Pack with

the following steps:
i. Configure the datasource.xml file and run: dw_ds_automation.bat -task

ConfigureInitial -cp <CP_NAME>.
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ii. Deploy the task: dw_ds_automation.bat –cp <CP_NAME> –task Deploy.
iii. Activate the task: dw_ds_automation.bat –cp <CP_NAME> –task Activate.

Compact the BODS repository after each
redeployment

Tip: For versions prior to 9.40, with each additional CP redeployment, mainly performed during the
content development process, the SAP BusinessObjects Data Services repository database gets
heavier because the records in the Data Services are not deleted from the tables but only marked
accordingly. This leads to large local repositories, corruption, bad response times, andmore.

It is recommended to compact the SAP BusinessObjects Data Services repository from time-to-time
(ideally after each CP redeployment) as follows:

1. Open the SAP BusinessObjects Data ServicesDesigner.
2. Specify the SAP BusinessObjects Data Services repository database connection details.
3. Select Open File > Compact Repository.
4. Select Local Repository and click OK.
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Activate New Content
After you package and deploy new Content Packs, you activate the content in the XS Data Source
Management UI. Content that is created from databases, delimited files, as well as Excel files can be
activated in the customized Data SourceManagement activation.

Select the Data Source Type according to your specific Content Pack source, as follows:

l MSSQL
l Oracle
l MySQL
l Delimited File
l Excel File
To access:

In the XS application, select Admin > Data Source Management. Click Add Data Source and
select the relevant Content Pack you have created.

Tasks

Activate a new Content Pack
1. In the XS application, select Admin > Data Source Management.
2. Click theAdd data source to open the Data source wizard. The Add Data Source page opens.
3. Select the CP you created and click Next.

The relevant data source page opens.
4. Enter and select the configuration parameters.
5. Complete the wizard.

The data source instance is activated.
For details on all XS Data SourceManagement capabilities, see Data SourceManagement in the IT
Executive Scorecard Administrator Guide.

UI Description

CP Activation Page Options
Activation parameters are based on the Data Source Type of your Content Pack.

MSSQL Database Source CP
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UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type SelectMSSQL.

Username Enter your username used to log on to the database.

Password Enter your password used to log on to the database.

Hostname/IP Address Enter the SQL server database hostname or IP address.

Port Enter the server port number.

Database Name Enter the database name used by the CP.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

MySQL Database Source CP

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type SelectMySQL.

Username Enter your username used to log on to the database.

Password Enter your password used to log on to the database.

Hostname/IP
Address

Enter theMySQL server hostname or IP address.

Port Port for database connections.

Initial Load Period
(months)

Select the number of months from which you want the initial data loaded.

Oracle Database Source CP

Note: TheOracle database can have both Server ID (SID) and Service Name properties, but the
user should specify only one. If you define the SID, then the SID is used, and if you define Service
Name, then Service Name is used. If you define both in the UI, only SID is used.
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UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type Select Oracle.

Username Enter your username used to log on to the database.

Password Enter your password used to log on to the database.

Hostname/IP
Address

Enter the Oracle server hostname or IP address.

SID Enter the unique name of the database.

Service Name Enter the alias used when connecting.

Initial Load Period
(months)

Select the number of months from which you want the initial data loaded.

Delimited File Source CP

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Select the time zone for the data source.

Data Source Type Select Delimited File.

directory Path Enter the path where the data source file is located.

Encoding Enter the text encoding of the file. The default is UTF-8.

Field Delimiter Enter the field delimeter for the file, such as ','.

Row Delimiter Enter the row delimeter for the file, such as '\r\n'.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

Excel File Source CP

UI Element Description

Instance name Enter a name for the data source instance you are activating.

<CP name> Version 1

Time Zone Enter the time zone for the data source.
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UI Element Description

Data Source Type Select Excel File.

directory Path Enter the path to excel data source file.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.
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Upgrade Tool
If you intend to develop content from a previous version, youmust perform the upgrade process. This is
done to allow file and content compatibility and simplifies themerging and entity deletion processes.

Learn More

When to perform an upgrade

An additional upgrademust be performed in the following cases:

l When you are usingmodels from before the IDE was upgraded.
Possible issues include:
l ETLGen, BODS Export failures.

l Validation errors for all designers when using theValidate button.

l Content pack files cannot be viewed in the default editor.

l Content pack name starts with “null”.

l Entity problems.

l When you have upgradedmodels in a non-upgraded IDE version.
Possible issues include:
l ETLGen, BODS Export failures.

l Validation errors for all designers when using theValidate button.

l In Package Explorer, entity files cannot be viewed by the default editor or entity files appears with
UUID instead of entity name.

l The Upgrade option does not appear in the DW Content menu.

Note: The following content changes require that you perform an additional upgrade on your IDE
version.

l Reverting to older content (https://hpln.hp.com/group/executive-scorecard).

l Merge of content from another developer's environment using a previous IDE version.
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Tasks

Upgrade the IDE

To perform an upgrade, select DW Content > Upgrade.
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Advanced Development
Following the ETLGenerator process, you can optionally access the following features and processes
for advanced content development.

• Data Source Explorer 91
• Generate Entities Automatically 102
• Data Source Extraction Customization 109
• Create an Entity from an Excel File 111
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Data Source Explorer
The IDE provides a Data Tool Platform plug-in which enables you to connect to a specific data source
and browse the database.The Data Source Explorer enables connection to the data sources through
the SQL, Oracle andMySQL drivers. You can then browse the database tables, make queries, and
view the data source information.

You can also connect to file based data sources with the Open Data Access (ODA). It enables you to
interface with an external data provider.

For details on the ODA, see the Eclipse DTP tutorials.

For details on 816381 extractors for each product, see "File Based Integration (FBI) Extractor. " on
page 10

To access:

l To create a new data source connection profile, in the IDE main page, selectWindow > Show
View > Other > Data Management > Data Source Explorer, right click Database Connections
and right-click New.

l To create a flat file data source, selectWindow > Show View > Other > Data Management >
Data Source Explorer, right click Flat File data Source and right-click New.

Tasks

This section includes the following tasks:

Create a new database connection in the Data Source Explorer
1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer. The

Data Source EXPLORER tab is displayed.
2. Right-click Database Connections and then right-click New.
3. Select Oracle, SQL Server, or MySQL and click Next.
4. Enter theDatabase, Host, Port number, Username andPassword.
5. Click Test Connection to check for errors with the connection to the database.
6. Click Finish to enable the connection to the database.
You can change the driver definitions or create another driver.

Modify driver definitions

Note: IDE provides out-of-the-box drivers for MSSQL, Oracle, andMySQL.
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1. Navigate toWindow > Preferences > Data Management > Connectivity > Driver Definitions.
2. Select the driver you want to change, or click Add to add an additional driver.

For details on the Data Tool Platform, see the Eclipse DTP tutorials.

Connect to flat file data sources
The IDE can connect to a flat file which contains data. The supported file types are: csv, ssv and psv.
The flat file may contain:

l A file where the first row includes the headers and the rest of the file contains the data.
l A file where the first row includes the headers and the second row contains the data types of each
header. The rest of the file contains the data.

l A file where there is only data and does not contain headers or data types.
1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer. The

Data Source EXPLORER tab is displayed.
2. Navigate toODA Data Sources > Flat File Data Source, right-click and select New.
3. Enter the relevant details in the New Flat File Data Source Profile wizard.

For details, see the Eclipse DTP tutorials.

UI Description

Data Source Explorer

Note: IDE provides out-of-the-box drivers for MSSQL, Oracle, andMySQL.

l Right-click Database Connections and select New to create a new database connection. For
details, see "Data Source Connection Profile" below

l Right-click Flat File data Source and right-click New to create a flat file data source. For details,
see "Create Connection Profile" on page 99

Data Source Connection Profile
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User interface elements are described below (when relevant, unlabeled elements are shown in angle
brackets):

UI Element Description

<Driver List> Select SQL, Oracle, or MySQL Server.
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Specify a Driver and Connection Details

l MSSQL Server

UI
Element Description

Database Enter the specific database name.

Host Enter the host server.
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UI
Element Description

Port
number

Enter the database port.

User
name

Enter the database username.

Password Enter the database password.

New Driver Definition. Click to configure new driver definitions. For details, see the
Eclipse DTP tutorials.

Edit Driver Definition. Click to edit the current driver definitions. If you
receive an error for the driver, check that the correct path is displayed in the
driver files of the JAR list.
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l Oracle Server

UI
Element Description

SID Enter the Server ID, the unique name of the database.

Host Enter the host server.

Port Enter the database port.
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UI
Element Description

number

User
name

Enter the database username.

Password Enter the database password.

New Driver Definition. Click to configure new driver definitions. For details, see the
Eclipse DTP tutorials.

Edit Driver Definition. Click to edit the current driver definitions. If you receive an
error for the driver, check that the correct path is displayed in the driver files of the
JAR list.
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l MySQL Server

User interface elements are described below (when relevant, unlabeled elements are shown
in angle brackets):
UI
Element Description

Database Enter the specific database name.

URL Enter the database URL.
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UI
Element Description

User
name

Enter the database username.

Password Enter the database password.

New Driver Definition. Click to configure new driver definitions. For details, see the
Eclipse DTP tutorials.

Edit Driver Definition. Click to edit the current driver definitions. If you receive an
error for the driver, check that the correct path is displayed in the driver files of the
JAR list.

Create Connection Profile

User interface elements are described below:

UI Element Description

Name Enter any name for the flat file.

Description (optional) Enter a description of the data source. This field is optional.
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Define directory or a File URI

UI Element Description

Select home
directory

This option is not supported

Enter file URI Browse to the relevant flat file.

Select charset Select the relevant character set.

Select flatfile style Select the flat file type: CSV, PSV, SSV. The IDE does not support the .tsv
style.

Use first line as
column name
indicator.

Select when using a flat file that has headers and data (no data types).
Select when using a flat file that contains both headers and data types.

Use second line as
data type indicator.

Select when using a flat file that contains both headers and data types.

Use trailing null
columns.

Not relevant to the IDE.
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UI Element Description

Test Connection Click to check the connection to your flat file.

Note:When activating a flat file as a source, remove the data types row from the file.

For details, see the Eclipse DTP tutorials.
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Generate Entities Automatically
You can generate entities from the source database tables or views, as well as flat files based on .csv
format. This enables you to automatically create Source, Integration or Target entities. Using the Data
Source Explorer, you can connect to the source database and navigate to the source table or view. The
entities are created based on the specific sourcemetadata. MSSQL, Oracle, andMySQL source
databases are supported. You can then load the entity to a new designer located in an existing project.
The entity is then displayed in the new Engineer Stream Designer.

Note:

l The following file formats are supported: .csv, .psv, and .ssv.
l The following file models are supported:

l Column name in first row.

l Column name in first row and data type in second row. Flat files can only be extracted using
this model.

l No column name or data type.

Tasks

This section includes the following tasks:

Automatically generate entities fromdatabase tables or views

Note: You can generate Source, Integration or Target entities using the Entity Generator wizard.

1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer. The
Data Source EXPLORER tab is displayed.

2. Select either an SQL, Oracle, or MySQLDatabase and connect to the database.
3. Navigate to Tables orViews and right-click the relevant table or view from which you want to

generate the entity and select Generate DWH Entity.
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4. In the Scenario page:
a. Select the type of content pack: Source Content Pack, Integration Content Pack, or

Target.
b. If you have selectedSource Content Pack, Integration Content Pack, select the relevant

content pack.
When you select the Source Content Pack, the Integration Content Pack is automatically
displayed.
If you have selected Target, select whether the entity is defined as a Fact orDimension.

Note:When you generate an entity from anOracle database, make sure that if you use
reserved words, they are placed in quotationmarks, for example, "NUMBER".

5. Click Next.
6. In the Load to Designer page, select to either load the entity to aNew Designer, orNo Designer .
7. If you selectedNew Designer, select from the drop down list, the project where you want the

specific Designer to be located.
8. Click Finish to complete the wizard and create the entity. The new entity is now displayed in the

IDE Package Explorer, and if relevant, loaded in the assigned designer canvas.

Automatically generate entities from flat files
1. Navigate toWindow > Show View > Other > Data Management > Data Source Explorer. The

Data Source EXPLORER tab is displayed.
2. Navigate toODA Data Sources > Flat File Data Source and right-click the file from which you

want to generate the entity and select Generate DWH Entity.
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3. In the Scenario page:
a. Select the type of content pack: Source Content Pack, Integration Content Pack, or

Target.
b. If you have selectedSource Content Pack, Integration Content Pack, select the relevant

content pack.
When you select the Source Content Pack, the Integration Content Pack is automatically
displayed.
If you have selected Target, select whether the entity is defined as a Fact orDimension.

4. Click Next.
5. In the Load to Designer page, select to either load the entity to aNew Designer, orNo Designer.
6. If you selectedNew Designer, select from the drop down list the project where you want the

specific designer to be located.
7. Click Finish to complete the wizard and create the entity. The new entity is now displayed in the

IDE Package Explorer, and if relevant, loaded in the assigned designer canvas.

UI Description

Entity Generator Wizard

Scenario page

Content Extension Guide for XS IDE Version 9.50

HP IT Executive Scorecard (9.50) Page 104 of 117



Note: If you select to generate Integration and Target entities, SSI Column Mapping is
automatically performed and displayed in the relevant designer .

UI Element Description

ID Enter entity name. The current table or view name is the default.

Source
Content
Pack

Select the checkbox and the Source content pack for the specific entity. This
generates a Source entity and automatically selects the relevant Integration content
pack.

Notes:

l If there is only one Source content pack in the workspace it is entered
automatically and cannot be changed.

l This checkbox is disabled if there is no Source content pack in the workspace.

Integration
Content
Pack

Select the checkbox and the Integration content pack for the specific entity. The
Integration content pack is automatically populated when the Source CP is selected.

Notes:

l If there is only one Integration content pack in the workspace it is entered
automatically and cannot be changed.
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UI Element Description

l If only Integration Content Pack is selected, theNext button is disabled, and the
entity cannot be loaded to a designer.

l This checkbox is disabled if there is no Integration content pack in the workspace.

Target Select the checkbox and whether the Target entity is defined as aDimension or
Fact. The entity is placed in the core-cp.

If only Target is selected, the entity is loaded to the Architect Target Designer.

Load to Designer page

UI
Element Description

No
Designer

Select the checkbox and the generated entity is not displayed in a designer canvas.

New
Designer

Select the checkbox for the generated entity to be displayed in a designer canvas.
Select an existing project from the drop down list where the designer will be located.
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UI
Element Description

Note: If a Target entity was generated then the entity is loaded into an Architect
Target Designer only. For Source and Integration entities, they are loaded into an
Engineer Stream Designer.

Complete Entity Generation with SSI mapping displayed in Stream Designer

IDE Data Types

The follows shows Database Data Types and the conventions used for them in the IDE entity columns.

Database Data Type IDE Data Type

BIGINT Int32

INTEGER(INT), SMALLINT, NUMERIC, NUMBER Int16

FLOAT, DOUBLE_PRECISION Float

CHARACTER, NVARCHAR, VARCHAR, VARCHAR(2),
CHARACTER_VARYING, CHARACTER_VARYING

VarChar (size)
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Database Data Type IDE Data Type

CHARACTER_LARGE_OBJECT, CLOB, TEXT VarChar (4000)

DATE, TIMESTAMP, TIME, DATETIME, Integration: Date Time
Target: Localized Date Time

RAW16 No IDE Data Type. User must
select a data type or delete the
column.

IMAGE No IDE Data Type. User must
select a data type or delete the
column.

BLOB No IDE Data Type. User must
select a data type or delete the
column.
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Data Source Extraction Customization
Integration with data sources is performed using File Based Integration (FBI). In order to generate the
query executed for the data source, the ETL indicates to the FBI module which source entity to extract.
The FBI then extracts the correlatingmetadata definitions, and uses them in order to formulate a query.

Tasks

This section includes the following tasks:

Customize the Source Model
You can customize the generated query by modifying the source entity xml file. This updates the
sourcemetadata in the DataWarehouse andmatches it to the customized source.

1. Modify the xml and load it into the DataWarehousemetadata repository, use dw_import_defs.bat.
2. Change the SQL query from the FBI log and run the query on the source databasemake sure the

query is correct and can run without errors.
3. Identify all of the changes.
There are various types of customizations to the sourcemodels supported by the DWH. This
document emphasizes cases where the data source that you extract information from is based on
RDBMS, and entities which are already modeled in the DWH have had field names or table names
changed in the data source’s structure.

The Data Source’s sourcemodel metadata xml files are located under:

<HP-XS>\agora\ContentPacks\<CPname>\dataModel\dataIntegration\source\
<CPName>\<product_version>\<DB_type>\<entity_name>.xml

ExampleC:\<HP-
XS>\agora\ContentPacks\SM\dataModel\dataIntegration\source\SM\9.2\oracle\SM_
INCIDENTSM1_SRC.xml

Make changes in a field name
l Open the entity xml sourcemodel file and update the source field names in the
datasourcecolumnname property in theColumnMapping tag:

Example

<ns1:ColumnMapping extractioncolumnidentifier="<identifier>" notapplicable="N" >

<ns1:DataSourceMapping datasourcetablenameoraliasname=" <name>"
datasourcecolumnname=" source field name" datasourcecolumntype="XXXXX"/>
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</ns1:ColumnMapping>

Make changes in a table name
1. Open the entity xml sourcemodel file and update theDataSourceJoin andDataSourceWhere

tags with the changes.

Examples

<ns1:DataSourceJoin>table name</ns1:DataSourceJoin>

<ns1:DataSourceWhere>field name=1</ns1:DataSourceWhere>

<ns1:DataSourceJoin>table1 A LEFT JOIN table2 B ON A.AAAAA =
B.BBBBB</ns1:DataSourceJoin>

<ns1:DataSourceWhere>A.AAAAAAAA IS NOT NULL</ns1:DataSourceWhere>

2. Change the datasourcetablenameoraliasname property in theColumnMapping tag to the new
value.

Example

<ns1:ColumnMapping extractioncolumnidentifier="XXXX" notapplicable="N" >

<ns1:DataSourceMapping datasourcetablenameoraliasname=" A" datasourcecolumnname="
XXXX" datasourcecolumntype="XXXXX"/>

</ns1:ColumnMapping>

Update the data warehousemetadata
1. Run the command on the sourcemodel xml update file: C:\<Installation

Directory>\agora\DataWarehouse\bin>\dw_importdefs.bat –topdir <SOURCE MODEL
XML FILE DIR>

2. Start the ETL again using the DW ABC Streams Management UI. For details, see Content Flow
Management in the IT Executive Scorecard Administrator Guide.
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Create an Entity from an Excel File
You can generate an entity from an Excel file using the IDE Engineer Stream Designer. In the source
entity Properties, youmust specify the Table Name/Join Condition field as the Excel file and theWhere
field as the Excel worksheet. After you generate your content, make sure to activate the new Content
Pack in the Data SourceManagement UI as anExcel file in theData Source Type field. For details
see "Activate New Content " on page 84

Tasks

Generate an entity froman Excel file
1. Define a new Content Pack project. For details see "Define New Content Pack Project" on

page 59.
2. Define the Architect Target Designer project and create the Target entity. For details see

"Architect Target Designer Tasks" on page 34.
3. Define the Engineer Stream Designer project. For details see "Engineer Stream Designer Tasks"

on page 46.
4. Proceed with the Engineer Stream Designer tasks by loading the relevant entities.
5. Select New Source Entity in the Source section and click the canvas. A Source entity is

displayed.
6. Click Source to Integration Relation and drag the display arrow from the Source entity to an

Integration entity. All columns from the Integration entity are copied to the Source entity with
default values.

7. Click the Source entity.
8. In the Properties tab of the Source entity, enter the excel file name in the Table Name/Join

Condition field, for example ALT_ACTUALCOST.xls
9. In the Properties tab of the Source entity, enter the excel worksheet name in theWhere field, for

example DATA.
10. Add columns and perform mapping as necessary. The column names have tomatch the actual

excel file columns.

UI Description

Excel
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Properties tab for Source

To view the Properties tab, right-click on the specific entity and click Show Properties View.

UI
Element Description

General
tab

General attributes:

l ID. The entity ID.
l Content Pack. The Source Content Pack information.
Data Source SQL Clauses:

l Group by. This field is not applicable.
l Table Name/Join Condition. Enter the Excel file name including the extension. It
can have the .xls, or .xlsx extension.

l Where. Enter the specific excel worksheet name.

Columns
tab

Displays column information. The Source entity receives all of the Integration entity
properties.

l ID. The ID of the column. It is taken fro themapped integration column and is read-
only.

l Type. Select Fixed, Direct, orRule. If you select Fixed, youmust enter a Fixed
Value. if you select Rule, youmust enter the Calculation Rule.

l Not Applicable.
l Table Name. Based on table name entered in the General tab. Relevant only if
Direct type is selected.

l Column Name. The field name. Must be what appears in the excel file columns.
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UI
Element Description

l Fixed Value. The fixed value of the column. Relevant only if Fixed type is selected.
l Calculation Rule. The calculation rule of the column. Relevant only if Rule type is
selected. The IDE does not support non UTF-8 characters in theCalculation Rule
field.

Content Extension Guide for XS IDE Version 9.50

HP IT Executive Scorecard (9.50) Page 113 of 117



Next Steps
Following the IDE content development and extension process, you have created additional Content
Packs for use in the DataWarehouse. This provides data to IT Executive Scorecard. Using the tools of
IT Executive Scorecard, you can customize andmodify your data, in order to access and display it
according to specific formulas and parameters. The process includes:

l Create a custom FBI Extractor:Enables you to develop andmodify an extractor for use with new
content. For details, see the FBI Extractor SDK Guide.

l Manage the Data Sources:Enables you tomanage the integration of extended or new data into the
data warehouse through the activation of data sources.
To access: In IT Executive Scorecard, select Admin > Data Source Management. For details,
see Data SourceManagement in the IT Executive Scorecard Administrator Guide.

l Manage the ETL:Enables you to perform the essential tasks related to ETL and stream
functionality. It displays the state of active streams, and enables you to schedule and control stream
activity. It also allows you to view the historical data and the archived stream definitions. All ETL
management and functionality is accessed and performed through the Content Flow Management
men in the ADMIN tab.
To access: In IT Executive Scorecard select Admin > Content Flow Management. For details,
see Content Flow Management in the IT Executive Scorecard Administrator Guide.

l Create your Context in the Context Designer:Enables you to create andmanage Contexts
(universes). The universes can be based on your target schema tables or on .CSV files that can be
uploaded to the target schema using the Context Designer.
To access: In IT Executive Scorecard, select Admin >Semantic Layer > Semantic Layer. The
Context Management page opens. For details, see Semantic Layer - Context Designerin the IT
Executive Scorecard Content ReferenceGuide.

l Create KPIs in the Studio:Enables you to create andmanage all of the displayed KPI elements
(based on your content), as well as their interactions with each other: wiring, drill downs, and other
features.
To access: In IT Executive Scorecard, select Studio. For details, see Create the Executive
Dashboard Contents in the Studio in the IT Executive Scorecard Business Analyst Guide.

l Create Executive Pages in the XS Dashboard:Enables you to set up pages that include
components that are of interest to specific users or groups of users. For each page, the administrator
defines the layout of components on the page, and the interaction of the page components with one
another.
To access: In IT Executive Scorecard, select Studio. For details, see Dashboard Display in the
IT Executive Scorecard Business Analyst Guide.

l Create CAPs:Enables you to create Content Acceleration Packs that include Scorecards, KPIs,
Dashboard pages that display the Scorecards and KPI components, Contexts (universes), and
.CSV files.
To access: In IT Executive Scorecard, select Admin > Context Management
> CAP Management. For details, see Create Content Acceleration Packs in theContent
Acceleration Packs Guide.
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Release Notes

Compatibility
The IDE version 10.00 is not compatible with all previous XS versions.

What's New in this Version
IDE version 10.00 is compatible with HP IT Executive Scorecard 10.00.

There are no new features in IDE 10.00
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Content Extension Guide for XS IDE Version 9.50 (IT Executive Scorecard 9.50)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to SW-Doc@hp.com.

We appreciate your feedback!
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